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Introduction to Google Sites 
Get Help at the TLMC 
1. Get help with class projects on a walk-in basis; student learning assistants are on duty daily 

2. Group workspaces available at the TLMC – just walk in 

3. See TLMC website for lab hours and other information 

 

Activate your NDSU Google Account 

Create, Delete, or Restore a Site 

Working with Pages 

Adding Content and Editing Your Site 

Modifying Your Site 

Editing Your Site Layout 

Editing and Configuring Your Sidebar 

Editing and Configuring Your Navigation Bar 

Manual Organization 

Sharing Your Site 

Revision History 

Adding a Table of Contents to a Page 

Comments and Attachments 

Embed or Link to Video and Audio 
 

Activate your NDSU Google Account 
NDSU is a Google Apps university, so all students, staff, and faculty have an NDSU Google account. Your 
NDSU Google account provides access to Google Sites and Google Drive. Before you can use it, you need 
to activate your account; to learn how, go to: 
http://www.ndsu.edu/its/help_desk/collaboration_and_storage/google_drive/   

Google Drive provides 30 GB of space for each user and can be used to create, share, and store 
documents, spreadsheets, and presentations. It can also be used for collaborative content authoring in 
real time.  
NOTE:  NDSU Google Apps does not include Gmail or Google calendar. 

What is Google Sites? 

Google Sites is a Web application (you do not download the program) that lets you easily create and 
manage your own websites and wikis. Google Sites allows you display a variety of information in one 
place—including videos, slideshows, calendars, announcements, presentations, attachments, and 
text—and share it for viewing or editing with others: a small group, an entire organization, or the 
world. You control who has access to your site. 

Here is what you can do with Google Sites:  

• Customize your site.  

• Create sub-pages to keep your content organized.  

• Choose page types: Web pages, announcements, file cabinet. 

• Have a central location for your Web content and offline files. 
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2 
• Keep your site as private or public as you would like. 

• Search across your Google Sites content with Google search technology.  

Create, Delete, or Restore a Site  
Go to http://www.sites.google.com and sign in.  

Create a Site 

Once you have signed in to your Google account, you can start creating your site. Here's how: 

1. Click the Create button.  

2. Click Blank Template. 

3. Name your site. The URL or Web address for your site (for example, 
sites.google.com/site/yoursite) will appear in the URL box. 

4. Pick a theme for your site, if you wish. You can change it or modify it later. 

5. Under More options, enter Site categories or Site description, if you wish. 

Delete a Site 

Follow these instructions to delete a site: 

1. From the Open More Actions menu 
(upper right hand corner—circled here), 
select Manage Site.  

2. You will be directed to the General page of the Manage Site area. 

3. Click the Delete this site button (about 
halfway down the page). A confirmation box 
appears.  

4. Click the Delete button to confirm that you 
want to delete the site. 

Restore a Site 

To restore a site, if it was deleted within 30 days, follow these steps: 

1. Go to www.sites.google.com  

2. On this page, you will see all sites that you own. Find the site that you would like to restore in 
the Deleted Sites section of this page. 

3. Click the Restore site button and your site will be restored. 

Working with Pages 
Your Google Site is a collection of individual pages. 
Unless you create a site from a site template, your site 
begins as just a single home page.  

Create a New Page 

1. From your home page, click the New page icon 
(circled here).  

2. Name your page. Google Sites will generate a 
URL (Web address) based on the name you choose, but you can alter it by clicking Change.  

NOTE: You can create as many pages 
you like within a site, but note that 
your site may not work well with 
more than 1,000 pages/attachments. 

NOTE: Only owners have the ability to delete 
sites. As the owner, you can visit the URL and 
recover your site within 30 days after 
deletion. 
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3. Next, choose a page template. Usually this would be Web Page, but you may choose another 

page type. See the “Guide to different page types” in the next section of this document.  

4. Choose where to locate your page within your site:  

• Put page at the top level: Top-level pages are the most general in your site's hierarchy. They 
exist at the same level as your home page, and it's easy to create sub-pages beneath them. 
They are best for main categories of your site's content.  

• Put page under [current page]: The second option is to place your new page as a subpage of 
the page you were on when you clicked the New page icon. 

• Choose a different location: Choose to nest your page under any other page in your site.  

5. Click Create.  

Guide to Different Page Types  

When you create a new page for your Google Site, you can choose from among a number of 
different page types, depending on what type of content will be on that page. Below is some 
information about each page type and how you might use it. 

• Web page 
A Web page is the simplest kind of page; you can write content, embed gadgets, and 
arrange it however you like. The Web page has standard formatting controls like bold, italic, 
and underline, bullets, and more. You can attach documents from your hard drive to the 
bottom of the page, and you can let other site collaborators comment on your pages. 
Google Sites periodically saves versions of your page as you make edits, so it’s easy to go 
back to earlier versions of the page to make comparisons or undo changes. 

• Announcements 
Much like a blog, announcement pages display posts you make to the page in chronological 
order, starting with the most recent. For example, an announcement page would be great 
for keeping a record of weekly meeting notes, while providing quick access to the most 
recent meeting info. 

• File cabinet 
File cabinet pages let you store and organize files from your computer’s hard drive, making 
it an easy way to share files with other users of your site. Anyone subscribed to the page will 
be notified when files are added, changed, or removed. 

• List page 
List pages let you make and organize lists of information. Items on the list are easy to add, 
edit, and remove, and viewers of the list can sort it by any column. Like the file cabinet page, 
subscribers are notified when items are added, changed, or removed. 

Delete a Page 

1. Go to the page you want to delete. You might 
need to click the Save button (upper right corner) 
and/or click the Edit page icon (circled here) 
before you can edit your Google Site:  
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2. Click the Open More Actions menu button.  

3. Select Delete page.  

4. Confirm you want to delete the page by clicking 
Delete. 

NOTE: You cannot delete your home page. 

If you delete a page, its sub-pages and attachments will be 
removed. If you accidentally delete a page, you have 30 
days to recover the deleted page, which will automatically 
restore its sub-pages and attachments. 

 

Recover a Deleted Page 
 

If you accidentally delete a page, you have 30 days to recover the deleted page and restore its sub-
pages and attachments. To recover a deleted page: 

1. From the Open More Actions menu, select Manage site. 

2. Select the Deleted items tab. 

3. Click the box next to the page you would like to recover. 

4. Click the Recover button. 
On the Deleted items tab, you can also see how long each page has left before it will be deleted 
permanently by looking under the Delete permanently column. If you want to delete a page 
permanently right away, you can click the box next to the page and click Delete permanently. Be 
careful, though – you cannot undo this action. 

Change Page Settings 

From the Open More Actions menu, select Page Settings. The following options will appear. 

Show page title 

Show links to sub-pages 

Allow attachments 

Allow comments 

Click the box to activate a feature. 
 

NOTE: Hiding your page title will not prevent your page title from showing up on your sidebar or 
horizontal navigation bar. To do this, you will need to remove pages from your sidebar or remove pages 
from your horizontal navigation bar (links are to online Google Help docs). 

Adding Content and Editing your Site 
Be sure to check out all the Google applications you can use with your Google account: 

• Google Docs (word processing) 

• Google Presentations (create slide shows) 

• Google Spreadsheets (create spreadsheets and charts and graphs) 

• Google Drawings (draw pictures, flow charts, diagrams, etc., with this drawing program) 

NOTE: Your sub-pages and 
attachments will be 
automatically recovered 
and restored when you 
recover a parent page. 
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Go to drive.google.com to create and store these documents. Once they are created, you can insert 
them into your Google Sites Websites. 

Add Content/Edit Your Page Using the Edit Toolbar 

To edit your site, click the Edit page icon in the upper 
right hand corner of the screen. (Sometimes you need to 
click the Save icon first.) 

 

The Edit toolbar (shown above) will provide you with the tools necessary to edit your site. Here's 
what each option on the Edit toolbar (shown above) does: 

Undo and redo changes.  Undo and redo changes by clicking the Undo and 
Redo arrow icons in the toolbar. Or use these keyboard shortcuts: Undo 
(Ctrl-z) and Redo (Ctrl-y or Shift-Ctrl-z). 
 

Change the font type and size.  Select the font type and size using the two 
drop-down menus. 

 

Edit text.  Add boldface type (B) and italics (I), underline text (U), and 
change the color of your text (A) or text background    
 

Create a link.  Highlight the text that you want to turn into a link, and click 
the Link button. A window appears with these options for creating your link: 
Sites page; Web address. You can also click the Create new page button 
(bottom left corner) to create a new page and link to it. 
 

Create a list.  Click the Numbered list button or the Bulleted list button, 
depending on the type of list you need to add to the site page. Then type 
the first item, and press Enter. The next number or bullet point appears.  
NOTE: The Tab key can help you indent your bullet points, while the Enter 
key will move back your indentation.  
 

Indent or move your list.  Click the two buttons next to the bulleted list to 
indent or move back the starting point when adding a bulleted or numbered 
list. Click twice to move each item two spaces, and so forth. 
 

Align your text.  You have the option to align the text on your page to the 
left, center, or right side of the page. 
 

Remove formatting and edit HTML.  You can remove the formatting from 
any part of your page by highlighting the relevant text and clicking this icon.  
NOTE: This is a handy tool if you copy and paste text from Word or another 
program and you need to remove unwanted formatting. 
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Click the HTML button to edit the HTML on 
your site. Keep in mind that Google limits 
the amount of editing that can be done. 
Some advanced coding will not work.  

When you edit a page directly in Google Sites, be sure to check out the 
various layout options for the page, available in the Layout menu 
(shown here).  

 

 

 

Ways to Add Content 

• Insert images, Google documents, etc., 
from the Insert menu. 

• Type directly on the page  (see next 
section) 

• Copy and paste text from Word  (the formatting will be copied, too, so use the Remove 
formatting tool on the editing toolbar, if necessary, to remove unwanted formatting (circled 
below). 

 
Add an image 

To insert an image: 

1. Place cursor where you wish to add an image. 

2. From the Insert menu, select Image. 

You can insert an image from your hard drive (or another drive (click the Uploaded images radio 
button and then click the Upload Images button and navigate to the image file) or you can link to a 
photo stored on the Web by selecting Web address (URL) and entering the Web address. 

In the Alt text (optional): box, add an Alt text tag, which is a short textual description of the image 
for accessibility purposes. 

You can use the Image Editing toolbar (shown below) to adjust the image. Select the image and the 
toolbar will appear. You can adjust the 
alignment; the size of the picture—
Small (S), Medium (M), Large (L) or 
Original size; turn the Wrap on or off; and Remove the image. 
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Modifying Your Site 
With Google Sites, you can easily change the overall appearance of your site by editing your site's name, 
theme, colors, and fonts. 

Change Your Site Name 

1. From the Open More Actions menu, select Manage Site.  

2. On this page, you can change your site name that appears by default in your header.  Simply 
replace the text in the Site name box. 

3. Or you could deselect “Show site name at top of pages” —this would be good if you inserted an 
image for the custom logo that was the right size and included text in the heading. 

Site Themes 

1. From the Open More Actions menu, select Manage site. 

2. Select Themes, Colors, and Fonts from the left sidebar. 

3. Under Base theme at the top of the page, click the drop-down menu and select the theme you 
would like to use for your site. A preview of what your site will look like will appear within 
moments on the page. 

4. Click the Save button to save changes. 

Site colors and fonts 

You can customize your site by changing the colors and fonts of most aspects of your site. 

1. From the Open More Actions menu, select Manage site. 

2. Select Themes, Colors, and Fonts from the left sidebar. 

 

3. Select the aspect of your site you would like to modify. For most options, you can choose to use 
the default for your site's theme, turn the option off, or choose a custom value. For images, you 
can choose a custom image. For text, you will usually be able to choose from a set of colors or 
enter in your own six-character color code. Changes you make will be reflected in the Preview 
area within moments. Some of the areas you can customize include:  

4. Entire page: These options will set the default for your site, though you can override much of 
this formatting by selecting specific fonts, colors or images in other sections or by formatting on 
a specific page. 

5. Site header: If you have not turned off your header, these options control content in the area 
that appears at the top of each page. 
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6. Content area: These options control the main page area, where the majority of your content will 

be. You can override this formatting by making changes on individual pages. 

7. Content area gadgets: These items will format gadgets that you place in the main area of your 
pages, such as text boxes or slideshows. 

8. Sidebar gadgets: If you have not turned off your sidebar, these items will format the gadgets 
that you place in your sidebar. 

9. Horizontal navigation: If you have chosen to include a horizontal navigation bar, these options 
will format your horizontal menus. 

10. Click the Save button after applying any changes. 
 

Editing Your Site Layout 

NOTE: You must be an owner of the site to edit the site layout. 

1. From the Open More Actions menu, select Edit site layout. 

2. Along the top of your site, a toolbar will appear (shown above) that lists elements of your site. 
Clicking on one of the toolbar's buttons will toggle that element on and off. You can also specify the 
site width from this toolbar. 

 

3. It's easy to make changes to individual elements of your site. To see what you can edit, hover your 
mouse over the parts of your site. Those that you can edit will be highlighted in blue (see image 
above). To make a change to an element, simply click anywhere in the highlighted area. You will be 
able to change the following elements:  

• Header: Change your header's height and alignment, and add a logo. 

• Horizontal navigation bar: Change your navigation bar's style and select which pages of your site 
will appear there. 

• Sidebar: Choose what to call your sidebar, how it will be organized, and what it will link to. 

• Footer: Add and format footer text. 

4. Once you've clicked an element and made adjustments in the dialog box that appears, click the box's 
OK button to save your changes. 

5. When you're done making all the changes you'd like, exit the layout editor by clicking the blue Close 
button in the top-right corner of your browser window. 
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Editing and Configuring Your Sidebar 
 Most site templates include a sidebar to help visitors navigate your site. The sidebar can also house 
sidebar gadgets, such as a text box or ads delivered through Google AdSense.  
 

Turning Your Sidebar Off and On 

1.  From the Open More Actions menu, select Edit site layout. 

2. Click the Sidebar button on the toolbar that appears at the top of the page to turn the Sidebar 
off and on. 

Adding Sidebar Elements 

When the Sidebar is turned on, by default it will appear on the left side 
of the Web page.  

1. To add a Sidebar page element, on the black Sidebar bar, click the 
Add a sidebar item button +. 

2. Scroll down to see options. Try adding a Text element: scroll to the Text option and click the 
Add button. 

3. Move your pointer under the Sidebar area until you see the black Text box bar. Click on the blue 
highlighted area to enable the Configure Text Box dialogue box. 

4. Add a Title and Content as you wish, and click OK. The text will appear on your Sidebar. 

Deleting Sidebar Elements 

To delete an element, click the Delete link next to the element name. 
Make sure to click the Save button when you are done modifying your 
sidebar.  

Editing and Configuring your Navigation Bar  
You can add pages to, delete pages from and organize your Sidebar's navigation gadget in two different 
ways. Automatic organization takes less time, but manual organization gives you greater control over 
how your navigation is structured.  

Manual or Automatic Organization 

By default, your navigation gadget will automatically display pages according to how your site is 
structured. If you want more control over your navigation bar, you can manually organize your 
pages.  
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Change Organization Method 

 

1. From the Open More Actions menu, select Edit site layout. 

2. The Navigation element must be activated. If it is, it will appear when you move your pointer 
below the Sidebar bar. If the Navigation bar does not appear, add the Navigation Sidebar Item.  

To add a Sidebar item: 

a. On the black Sidebar bar, click the Add a sidebar item button +. 

b. Scroll down to find Navigation and click the Add button. 

3. Move your pointer under the Sidebar area until you see the black Navigation bar. Click on the 
blue highlighted area to enable the Configure navigation dialogue box. 

4. Make sure the box next to Automatically organize my navigation is checked for Automatic 
method or unchecked for Manual. 

Automatic Organization 

1. When you choose to Automatically organize 
your navigation bar, you can set the level of 
pages to show (circled in the figure at right). 
For example, if you choose 2, the navigation 
gadget will display any top-level pages and 
pages listed under them, but will not display 
any sub-pages listed under those second-level 
pages.  

2. And you can choose to include a link to your 
sitemap (which displays the hierarchy of your 
site) and your recent site activity by checking 
the box next to those options.  

3. If you want, you can type a name for the 
navigation bar in the box next to Title and check the box next to Display title to have that name 
displayed at the top of your navigation bar.  

4. Click OK.  

Move a Page (Only Available When Site is Set to Automatic Organization) 

If you have chosen to have your navigation gadget automatically organized and you want to change 
the order of pages, you must change the location of your pages.  

1. Go to the page you want to move. 

2. From the Open More Actions menu, select Move page. 

3. To move the page to the Top-Level, click the page at the top of the tree (the pages are listed 
under your site name).  

Automatic Organization 
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NOTE: Click the plus icon next to a page to see the sub-pages. 

4. To move the page to a sub-page location, click 
the page you want to be the parent page. 

5. When you are finished, click the Move button. 

 

 

 

 

 

Manual Organization 
1. When you change your setting to Manual (see “Change Organization Method” section above), 

you will see different options for changing the organization of your site (shown here) when you 
click on the Navigation sidebar. 

2. Click Add page to add a page from your site to 
your navigation bar. Then select the page in the 
pop-up window and click OK.  

3. Click Add URL to add a page from another site or 
an email address to your navigation bar. In the 
pop-up window, enter the URL of the page and 
the name you want to give to the link, then click 
OK.  

4. To delete a page from your navigation gadget, 
select the page in the Select pages to show box, 

then click on the   Remove icon .  

5. To change the order in which your pages appear, 
select the page in the Select pages to show box, 
then click the up arrow, down arrow, right 
arrow, or left arrow. Your pages will appear in 
your navigation bar in the same order in which 
they appear in the Select pages to show box.  

6. You can also choose to include a link to your sitemap (which displays the hierarchy of your site) 
and your recent site activity by checking the box next to those options.  

7. If you want, you can type a name for the navigation gadget in the box next to Title and check 
the box next to Display title to have that name displayed at the top of your navigation gadget.  

 

  

04-2014 



12 
 

Sharing your Site  
Once you have created your Google site, you can share it with your group members, friends, family, 
coworkers, or make it public.  

Share lets you choose who views, edits, and owns content on your site. Even with these controls, use 
care when you publish sensitive personal information on the Web, since people who may or may not 
have permission may still be able to access and use this information in unauthorized ways. Sensitive 
information includes social security numbers, financial account information, home addresses, and phone 
numbers. 

The default for your site is Private access. 

1. To change settings for sharing your site, click 
on the blue Share button in the top right 
corner of the window.  

2. The first item on this page is the Link to share; this is your Web address. 

3. The section Who has access allows you to change 
permission settings by clicking the Change link next 
to the specification. 

4. A list of options will appear, and you can set your 
site to Public, Anyone with the link, North Dakota 
State University, People at NDSU with the link, or 
Specific people. Select one and click the Save 
button. 

5. The third section on the page is the Invite people 
section. Here you can add individuals (type in their 
email addresses) and choose the level of access you 
wish to grant them. 

• Anyone you set to Can view can look at the site.  

• Anyone you set to Can edit can change the look 
and content of the site.  

• Anyone you set to Is owner can change the look and feel of the site as well as make 
administrative changes, such as deleting the site or adding new owners. 

The people whose email addresses you added will be sent an automated message when you add 
them unless you uncheck the box next to Notify people via email. You can add a message by clicking 
the Add message link. You can also opt to have the invitation sent to you as well by checking the box 
next to Send a copy to myself.  

Please note that for invitations to non-public Sites, users will need to sign in with a Google Account 
before they can accept the invitation.  
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Revision History  
While you and your collaborators are editing your site, you can keep track of changes (and of the person 
who made them), and even revert to a former 
version by using Revision History.  

1. From the Open More Actions drop-down menu, 
select Revision History. 

2. On the next page, you will see a list of the site 
versions, the date and time each was last edited, 
and the name of the person who made the changes.  

Revert to a Former Version 

If you change your mind about the most recent edits you or your collaborators made to the site, 
simply revert to a former version. Here's how: 

1. Click any version from the list. Optionally, while viewing a particular version, use the Compare 
two versions feature (link) to see the differences highlighted. 

2. After returning to the Version history view, click the (Revert to this version) link next to the 
version you'd like to revert to. 

3. Your document is reset to the version you selected. The replaced version is also included in the 
version history and can be restored as well. 

 

Adding a Table of Contents to a Page  
A table of contents is a great way for you to organize your content and is particularly helpful if you have 
a long page that includes multiple sections with headings. Adding a table of content will enable your 
visitors to easily navigate the page. All you have to do is mark the text you want for your table of 
contents with heading tags, then add a table of contents to your page. 

Marking Your Text Headings 

1. Navigate to the page where you want to embed your table of contents. 

2. Click the Edit page icon to open the site editor.  

3. Highlight the text (probably the headings on your 
page) you want to appear in the table of 
contents as links to those sections.  

4. From the Format menu, choose either Heading (H2), Sub-heading 
(H3) or Minor heading (H4) depending on what style you want. The 
lower the heading number, the more pronounced the text will be. 

5. Repeat these last two steps for all the text you want to appear in 
your table of contents. 

Adding the Table of Contents 

1. Place the cursor where you would like to insert your table of contents. 

2. From the Insert menu, select Table of Contents. 
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3. In the dialogue box that appears, set the width of your table of contents (in pixels—72 pixels is 

one inch) and choose how many levels of headings you want to show. (For example, if you have 
a list that has text formatted as H2, H3 and H4, choosing to show only two levels would mean 
that only the text formatted as H2 and H3 will appear in your table of contents.) Then click Save 
and a box marking your table of contents will appear on your page. 

4. On the page you are editing, click Save, and the table of contents will appear on your page.  

 

Comments and Attachments 
Site owners can enable a setting that lets editors of their site upload attachments or comment on a site 
page. Anyone viewing the site can download and view attachments, as well as view comments made on 
a page. The owner can leave these comments and attachments for others to view, or the owner can 
delete them. 

Enabling or Disabling Comments and Attachments 

Too enable or disable comments or attachments for a particular 
page: 

1. Navigate to the page that you would like to change.  

2. From the Open More Actions menu, select Page Settings. 

3. Check or uncheck the boxes next to Allow attachments or 
Allow comments. (Note other options.) 

4. Click Save and repeat for all pages you would like to change. 

Adding Comments 

1. Navigate to the page that you would like to add a comment to.  

2. Type your comment in the text box. 

3. Click Comment. 

Comment Notifications 

If you're subscribed to a page, you'll receive an email notification whenever someone other than 
you makes a comment on that page. If you're subscribed to an entire site, you'll get an email 
notification whenever someone other than you leaves a comment on any of that site's pages.  

• To subscribe to page changes, from the More drop-down menu, select Subscribe to page 
changes. 

You will also receive an email notification when someone mentions you in a comment (which they 
can do by typing "+" followed by your name), even if you aren't otherwise subscribed to that page or 
site. To unsubscribe to any of these mention-related notifications, follow the "Unsubscribe" link 
you'll see in any of the notification emails. 

Uploading Attachments 

When you enable the Attachments option, a link to Add 
files will appear at the bottom of that page. 

1. Click on the Add files link and browse for the file.  

2. A link to download or open the file will appear on the 
page along with information about who uploaded the 
file and when it was uploaded.  
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NOTE: Currently, attachments are limited to 20 MB or smaller. 

Deleting Comments or Attachments 

Only the creator of the comment or attachment, or an owner of the site, may remove comments or 
attachments. 

To delete a comment or attachment, these users can navigate to the page where the comment or 
attachment is located, then click the Delete icon to delete an attachment or click the drop-down  
menu next to the comment (far right) to Edit or Delete the comment. 

Viewing Attachments on Your Site 

You can view your sites attachments from the attachment management section of Sites:  

1. From the Open More Actions menu, select Manage site.  

2. Select the Attachments tab in the column on the left.  

3. You will be taken to a list of all of your attachments for the site. Here, you can rename, move, 
delete or replace your attachments.  

NOTE: Any images you insert in your website will appear here as well. 

Sharing Attachments from Your Site 

If you would like to share attachments from your site, you must have the person you are sharing the 
attachment with visit the page that the attachment is on, then click to download the attachment. 
That means that the person you are sharing the attachment with must have access to your site.  

In order to keep your site secure, you cannot just provide a link directly to the attachment. 

 

Embed or Link to Video and Audio 

Embed Video from Your Computer 

Video files need to be uploaded to your Google Drive before embedding videos into your site.  

1. Upload your video into your Google Drive area (go to drive.google.com and login). 

2. Share the video as Public. 

3. Open the Google Site where you want to embed the 
video. 

4. You should be in Edit mode. 

5. Place your cursor where you want to place the video, and from the Insert menu, select Drive > 
Video. 

6. You will be given options for size, playback, etc. 

NOTE: Video may take several minutes to "process" before being available for embedding. 

Embed a YouTube Video 

1. Place your cursor where you want to embed the video, and from the Insert menu, select 
YouTube. 

2. In the Insert YouTube Video dialogue box, paste the YouTube link in the specified location, 
select options, and click the Save button. 
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16 
Link to or Embed Audio 

An easy way to share audio files is to upload them using the Add files feature (see section on 
Comments and Attachments in this document). You can also use the File cabinet Web page style to 
provide a list of audio files. Either way, your viewers will have to download the audio files to play 
them and you will need to share them with specific users or make your page public. 

Search for ways to embed audio in Google Sites; there are some gadgets available you can try. 
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